Canon

Picture Style File Creating Software

Picture Style Editor
Ver. 1.18
Instruction Manual

Content of this Instruction Manual

PSE stands for Picture Style Editor.

In this manual, the windows used in the
examples are from Windows 7.

» indicates the selection procedure of the menu.

(Example: [File] menu » [Exit].)

Square brackets are used to indicate items such
as menu names, button names and window
names that appear on the computer screen.

Text inside < > indicates a key on the keyboard.

p.** indicates a reference page.
Click to move to the relevant page.

: Marks information that should be read
before use.

: Marks additional information you may find
helpful.

Switching Between Pages
Click on arrows on the bottom right of the screen.

@ : next page
() : previous page
: return to a page you had previously

displayed
Click on the headings on the right side of the
screen to switch to the contents page of that
heading. Also, click the item you want to read
about on the table of contents to move to the
relevant page.
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READ CAREFULLY BEFORE USING!

CANON SOFTWARE LICENSE AGREEMENT

IMPORTANT - READ THIS AGREEMENT BEFORE USING THE SOFTWARE ON THE CD-ROM
IN THIS BOX. BY USING THE SOFTWARE, YOU AGREE TO BE BOUND BY THE TERMS OF
THIS AGREEMENT.

This is a license agreement (the [Agreement]) between you and Canon Inc. ([Canon]).

IF YOU DO NOT AGREE TO THE TERMS AND CONDITIONS OF THIS AGREEMENT, DO NOT
USE THE SOFTWARE PROGRAM ON THE CD-ROM AND THE USER MANUAL IN THIS BOX
(COLLECTIVELY, THE [SOFTWARE]) AND RETURN THE SOFTWARE WITHIN 30 DAYS FROM
THE DATE OF PURCHASE TO YOUR POINT OF PURCHASE FOR A REFUND.

In consideration of the right to use the SOFTWARE, you agree to abide by the terms and conditions
of this Agreement.

1. LICENSE: Canon grants you the non-exclusive right to use the SOFTWARE only on a single
computer. You may physically transfer the SOFTWARE from one computer to another provided
that the SOFTWARE is used on only one computer at a time. You shall not install or use the
SOFTWARE on a network, multiple CPU, multiple site arrangement, or any other hardware
configuration where the SOFTWARE is accessible to more than one CPU or to more than one
user.

YOU SHALL NOT ASSIGN, SUBLICENSE, RENT, LEASE, LOAN, CONVEY OR OTHERWISE USE,
TRANSFER, COPY, TRANSLATE, CONVERT TO ANOTHER PROGRAMMING LANGUAGE,
ALTER, MODIFY, DECOMPILE OR DISASSEMBLE THE SOFTWARE, IN WHOLE OR IN PART,
EXCEPT AS EXPRESSLY PROVIDED IN THIS AGREEMENT.

2. BACK-UP COPY: You may make one copy of the SOFTWARE solely for back-up purposes, or
copy the SOFTWARE onto the permanent storage device (e.g. a hard disk) of your computer
and retain the original for back-up purposes. Any other copying of the SOFTWARE is a violation
of this Agreement. You must reproduce and include the copyright notice on the back-up copy.

3. SUPPORT AND UPDATES: Canon is not responsible for providing maintenance or support for
use of the SOFTWARE. No updates, fixes or support will be made available for the
SOFTWARE.

4. LIMITED WARRANTY AND LIMITATION OF LIABILITY: It is your responsibility to choose,
maintain and match the hardware and software components of your computer system. Thus
Canon does not guarantee uninterrupted service or correction of errors or that the functions or
performance of the SOFTWARE will meet your requirements. THE SOFTWARE IS LICENSED
ON AN [AS IS] BASIS AND WITHOUT WARRANTY OF ANY KIND. The CD-ROM storing the
SOFTWARE is warranted only against defective material under normal use for a period of ninety
(90) days after purchase from an authorized Canon dealer as evidenced by your sales receipt.
Your sole remedy for a defective CD-ROM shall be replacement of the same without charge
when returned by you at your expense to your point of purchase and proven to be defective
upon inspection. The replacement CD-ROM will be warranted for the remainder of the original
ninety (90) day warranty period of the defective CD-ROM. The limited warranty does not apply if
the failure of the CD-ROM resulted from accident, abuse or misapplication of the SOFTWARE
and shall not extend to anyone other than the original user of the SOFTWARE.

EXCEPT AS SPECIFICALLY SET FORTH IN THIS PARAGRAPH 4, CANON, CANON’S
SUBSIDIARIES, DISTRIBUTORS AND DEALERS DISCLAIM ALL WARRANTIES, EXPRESS OR
IMPLIED, INCLUDING ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE, WITH RESPECT TO THE SOFTWARE.

NEITHER CANON NOR ANY OF CANON'S SUBSIDIARIES, DISTRIBUTORS OR DEALERS IS
LIABLE FOR ANY DAMAGES HOWSOEVER CAUSED, INCLUDING WITHOUT LIMITATION,
DIRECT, CONSEQUENTIAL OR INCIDENTAL LOSS OR DAMAGE INCLUDING LOSS OF
PROFITS, EXPENSE OR INCONVENIENCE HOWSOEVER CAUSED OR ARISING OUT OF THE
SOFTWARE OR THE USE THEREOF.

NEITHER CANON, NOR ANY OF CANON'’S SUBSIDIARIES, DISTRIBUTORS OR DEALERS
SHALL HAVE ANY OBLIGATION TO INDEMNIFY YOU AGAINST ANY CLAIM OR SUIT
BROUGHT BY A THIRD PARTY ALLEGING THAT THE SOFTWARE OR THE USE THEREOF
INFRINGES ANY INTELLECTUAL PROPERTY OF SUCH THIRD PARTY.

5. TERM: This Agreement is effective upon your using the SOFTWARE and remains in effect until
expiration of all copyright interests in the SOFTWARE unless earlier terminated. You may
terminate this Agreement by destroying the SOFTWARE. This Agreement will also terminate
without notice to you if you fail to comply with any of the terms of this Agreement and you must
then promptly return the SOFTWARE. In addition, Canon may enforce its other legal rights.

6. U.S. GOVERNMENT RESTRICTED RIGHTS NOTICE: The SOFTWARE is provided with
restricted rights. Use, duplication or disclosure is subject to restrictions as set forth in either
subparagraph (c) (1) (ii) of the Rights in Technical Data and Computer software clause at
DFARs 252.227-7013 or subparagraph (c) (1) and (2) of the Commercial Computer Software
Restricted Rights Clause at FAR 52.227-19, as applicable.

7. SEVERABILITY: In the event that any provision of this Agreement is declared or found to be
illegal by any court or tribunal of competent jurisdiction, such provision shall be null and void
with respect to the jurisdiction of that court or tribunal and all the remaining provisions of this
Agreement shall remain in full force and effect.

8. CONTROLLING LAW: The terms of this Agreement as it relates to purchases of the Software in
the United States of America shall be governed and construed in all respects in accordance with
the laws and regulations of the State of New York, without reference to choice of law principles.
The terms of this Agreement as it relates to purchases of the Software in Canada shall be
governed by the laws of the province of Ontario.

9. OWNERSHIP: All rights, including but not limited to copyrights and trade secret rights, to the
SOFTWARE belong to Canon, its affiliated corporations and third party licensors. Your use of
the SOFTWARE is subject to the United States, Canada and other applicable copyright and
trademark laws and nothing in this Agreement constitutes a waiver of the rights of Canon, its
affiliated corporations and third party licensors under such laws.

Nothing contained in Paragraph 1 shall be construed to give Canon any ownership rights in any
images, graphics or textual material that you save in connection with the Software.

10.ACKNOWLEDGEMENT: BY USING THE SOFTWARE, YOU ACKNOWLEDGE THAT YOU
HAVE READ THIS AGREEMENT, UNDERSTOOD IT, AND AGREE TO BE BOUND BY ITS
TERMS AND CONDITIONS. YOU ALSO AGREE THAT THIS AGREEMENT IS THE
COMPLETE AND EXCLUSIVE STATEMENT OF AGREEMENT BETWEEN YOU AND CANON
CONCERNING THE SUBJECT MATTER HEREOF AND SUPERSEDES ALL PROPOSALS
OR PRIOR AGREEMENTS, VERBAL OR WRITTEN, AND ANY OTHER COMMUNICATIONS
BETWEEN THE PARTIES RELATING TO THE SUBJECT MATTER HEREOF. NO
AMENDMENT TO THIS AGREEMENT SHALL BE EFFECTIVE UNLESS SIGNED BY A DULY
AUTHORIZED OFFICER OF CANON.
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Introduction

Picture Style Editor (hereinafter, “PSE”) is software that allows you to edit
Picture Style to your unique image characteristics and save the edited
results as original Picture Style files.

What is a Picture Style file?

A Picture Style file (extension “.PF2” or “.PF3”) is an extended
function of a Picture Style. It differs from the eight preset Picture
Styles (Auto, Standard, Portrait, Landscape, Fine Detail, Neutral,
Faithful and Monochrome) and provides image characteristics that
are effective in a very limited number of scenes.

You can further expand your photographic expression by using a
Picture Style file effective for a specific scene.

Main Features of PSE

With PSE, you can use the functions below to edit Picture Style to
your unique image characteristics and save the edited results as
original Picture Style files (extension “.PF2” or “.PF3”).

Select a Picture Style to be used as a basis for your images

Set the [Sharpness], [Contrast], [Color saturation] and [Color tone]

Make adjustments to a specific color

Adjust the brightness and contrast (gamma characteristic)
In addition, you can register your saved original Picture Style files on
a camera with the Picture Style function and then apply those styles
to shot images. You can also use Digital Photo Professional
(hereinafter, “DPP”) to apply the styles to RAW images.

Color Management

Use PSE in a computer environment with color management.

Also, set the profile of the monitor you are using and the color space
of the sample image to be used to perform the adjustments, etc. in
the preferences window (p.20).

System Requirements

oS Windows 10, Windows 8.1, Windows 8, Windows 7*1

PC with one of the above OS preinstalled (Upgraded

Introduction

Computer | machines not supported)
* NET Framework 3.0 or later is required.*2 Contents
CPU 1.6GHz Pentium or higher*3
RAM Minimum 1GB*4 i
Displa Screen resolution: 1024 x 720 pixels or more a Sample
play Color quality: Medium (16 bit) or more
*1 Compatible with 32-bit/64-bit systems for all versions except Starter
iti Basic
Edition Windows

*2. NET Framework is Microsoft software. It is installed together with
PSE.

*3 Core 2 Duo or higher is recommended

*4 For Windows 10, Windows 8.1, Windows 8 or Windows 7 64-bit
systems, minimum 2GB

Check the Canon Web site for the latest system requirements, including

supported OS versions.

Sample Images for Adjustment

PSE enables you to use RAW images shot with EOS DIGITAL cameras*
(excluding the EOS DCS1 and EOS DCS3), PowerShot G7 X Mark II,
and PowerShot G9 X Mark Il as sample images for adjustment. You can
then save the completed adjustments as original Picture Style files.

* Compatible with RAW images shot with EOS D6000 or EOS D2000
that have been converted to RAW images using the CR2 Converter
and have the “.CR2” extension.

For information on CR2 Converter, refer to Canon Web site.
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Preparing Sample Images

PSE uses a sample image to perform the various adjustments and save
the adjusted results as an original Picture Style file. For this reason, a
sample image (p.2) to be used for this purpose needs to be prepared in
advance and saved on your computer.

The settings performed in PSE are saved as a Picture Style file (p.18)
which is separate from the sample image, and the sample image used
to perform the adjustments is not affected at all.

Starting up PSE

Double-click the [Picture Style Editor] icon on the
desktop.
The main window (Description on the right) appears when PSE
starts up.

Opening a Sample Image
Open a sample image and perform various adjustments with that image
as a basis.

Noise reduction to the sample images may be applied by PSE included
in EOS Solution Disk Ver.26 or later.

R
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Drag and drop a sample image to the main window.

Drag and drop

The sample image is displayed in the main window with the
camera settings at the time of shooting.
The [Tool palette] appears.

@ If you open an image as a sample image with PSE, the shot
settings on the camera will appear in the image. However, the
Auto Lighting Optimizer settings will not appear.
If you adjust a RAW image in DPP and then open it as a sample
image with PSE, the adjustments made in DPP will not appear in
the image.
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Basic Windows

Main Window

You can select the displ

ay magnification and the display method, etc. of the sample image.

Image rotation
(90 degree
increments to the
left or right)

Before and after
adjustment
comparison display
(Top/bottom split)

Help

File Edit View Tools

(p-6)

Before and after
adjustment
comparison display
(Left/right split) (p.6) —!

Normal screen

Cursor coordinates —

e ¥
.
,/.

X:1864 Y;2038 HSL: [ 85, 6,20]>[85, 6,20] ( 0, 0, 0) Work color space sRGB

position

o

Work color space display (p.20)

Color values of the cursor position (Before adjustment/after adjustment/
difference between before and after adjustment) (8-bit conversion)

Color display mode (p.17)

100% (actual pixel size)
view

Full view

ai—— Display magnification

(5 ratios: 12.5%, 25%,
50%, 100% and 200%)

Introduction

—_—

Contents

—_—

Preparing
a Sample

Basic

Windows

Pre-adjustments

—_—

Image
Characteristics

Saving

N —

Preferences

S —

Reference

QO
©




Introduction
Enlarging a Specific Area Adjusting While Comparing with the Original Image
You can enlarge a specific area in the main window to 100%. You can display before and after versions of an adjusted image in the
same window and perform adjustments while checking the adjustment Contents
In the main window, double-click the area you want results.
to enlarge.
9 Select [[E]] or [[]].
Preparing
. = a Sample

= 0 =

Basic
Windows
Double-click
Xi1864 Y2038 HSL: [85, B.20)=[85 6,200 ( D, 0, 0
) Pre-adjustments
The images are displayed split top and bottom or left and right.
. . . . . Image
[[E]](Top/bottom split) display  [[]] (Left/right split) display T
The area you double-clicked is enlarged to 100% (actual pixel Saving
size). If you wait for a while, it changes to a clearer display.
To change the display position, drag on the image or drag the
enlargemfent dlsplay position (p.7) in th'e [Navigator] window. Preferences
Double-click again to revert to the full view. :
The imagebefore adjustment The image efore adjustment
is displayed at the top, and is displayed on the left, and Reference
that after adjustment at the that after adjustment on the .

bottom. right.

QO
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Navigator Window

The display position of an image when it is enlarged in the main window
and the image histogram can be displayed in the navigator window. You
can also set warning indicators to prevent excessive settings being
made.

Display the [Navigator] window.
Select the [View] menu » [Navigator].

Enlargement display position

(p-6)
Move the display position by

dragging

bomoed RGE | R | G | B | Switches the histogram display

Histogram

Warning indicator setting

Show warning on images

si— Warning range

|§| [Y] in the histogram display indicates luminance.

Setting the Warning Indicators

You can set warning indicators for luminance values (Y) and color
values (RGB) which are useful for preventing excessive settings being
made. Luminance and color value domains which are outside the set
range blink as warning indicators on images in the main window.

Checkmark [Show warning on images] and select [Y]
or [RGB].

Show warning on images

e rce < (N

Enter the upper and lower limit values of the warning
range.
The domain where values are outside the upper and lower limit of
the range blinks on the image in the main window.
To stop the warning indicators, remove the check mark from the
[Show warning on images] checkbox.
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Introduction

Tool Palette —

You can adjust the image characteristics of the Picture Style file by using the various functions of the [Tool palette].

The adjustments made with the [Tool palette] are immediately applied to the image in the main window, enabling you to check the results as you work. Contents
We recommend that you make adjustments in the following order. —
(1) Adjust with the [Basic] tab sheet (p.10) _

(2) Adjust with the [Six Color-Axes] tab sheet (p.12) ';’ggﬁ:";l‘g

(3) Adjust with the [Specific Colors] tab sheet (p.13)

[Basic] Tab Sheet [Six Color-Axes] Tab Sheet [Specific Colors] Tab Sheet Basic
Make basic adjustments to image Make color adjustments to image Make fine adjustments to a specific Windows
characteristics. characteristics. color gamut.

Pre-adjustments

—_—

Image
Characteristics

Saving

N —

Preferences

S —

Reference

—_—

@ You can select the [View] menu » [Tool palette] to switch the [Tool
palette] show/hide.
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Pre-adjusting the Images

Sample images used in the adjustment process (p.2) which do not have
proper exposure or white balance can be adjusted using the
[Preliminary adjustment] window to correct their brightness and white

Introduction

Correcting the White Balance

Adjust to correct the white balance.

balance. . Contents
However, please remember that adjustments made with the [Preliminary orinicay e

adjustment] window are merely pre-adjustments for performing e

adjustments with the [Tool palette] (p.8). For this reason, adjustments U Preparing
made with the [Preliminary adjustment] window are not saved in the P — a Sample
Picture Style file which you create. ~ [colortemperature [ #2B Click white balance

If the sample image used for adjustments has proper exposure and % Click the [] button Basic
white balance, it is not necessary to make adjustments with the and then click on a point Windows

[Preliminary adjustment] window.

Correcting the Brightness

Select the [Tools] menu P [Preliminary adjustment].
The [Preliminary adjustment] window appears.
When the [Preliminary adjustment] window appears, the display
switches to normal display, even if the main window display is
showing a comparison of images before and after adjustment

(p.6).
Adjust to correct the brightness of the image.

Preliminary adjustme t

Brightnass adjustment

Drag to the left or right
to adjust

White balance adjustmant

Shot settings

The adjustments are applied to the image.

that is to be the standard
for white

The color temperature slider
Select [Color temperature] from the white balance
list box, then drag the slider left or right

Select the white balance

The adjustments are applied to the image.
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Making Basic Adjustments to Image Characteristics

Use the [Basic] tab sheet in the [Tool palette] to make basic adjustments
to image characteristics.

Select the [Basic] tab in the [Tool palette].
Load a Picture Style file (this page)

Save a Picture Style file
(p.19)

= m  Select a Picture Style to be
used as a basis (this page)

Adjust Sharpness, Contrast,
Color saturation, and Color
tone (p.11)

Adjust the Gamma
Characteristic for RGB (p.11)

Output

The [Basic] tab sheet appears.

Selecting a Picture Style to Be Used as a Basis

Select the Picture Style used as the basis of the adjustments from the
preset Picture Styles except Auto or Monochrome.

You can also register and use a Picture Style file effective for the scene
that you have downloaded from Canon Web site.

Select a Picture Style.

\ \ o\
) Six Color-Axe: Specific Colors | m 'E.

Base Picture Style

Standard -

The selected Picture Style is applied to the image.

Using a Downloaded Picture Style File
Effective for the Scene
Click the [[&']] button.
The [Open Picture Style file] window appears.

Select a Picture Style file to be registered and click
the [Open] button.
The selected Picture Style file is applied to the image.

|§| Original Picture Style files created with PSE (p.18) can also be

registered and used by following the procedure above.

Picture Style files compatible with PSE are files with the “.PF2” or
“.PF3” extensions.

You cannot select [Fine Detail] in [Base Picture Style] for the
images shot with a camera which does not have [Fine Detail] as a
preset Picture Style.
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Setting Sharpness, Contrast, Color Saturation and Color Tone

Drag each slider.

Sharpness:

Strangth:

Fineness:

Thrashold:

Contrast

Colar saturation:

Color tone;

The settings are applied to the image.

® [Fineness] or [Threshold] in [Sharpness] cannot be set for the
images shot with a camera which does not have [Fine Detail] as a
preset Picture Style.

Adjusting the Gamma Characteristic for RGB

You can use the tone curve to adjust brightness and contrast under
RGB.

Use the tone curve in this tab sheet before adjusting with the [Six Color-
Axes] tab sheet or [Specific Colors] tab sheet.

Adjust the brightness and contrast.

Tone curve (RGE)

Click to add a [[1]
(adjustment point) and
adjust by dragging

The value of the

[ ;

‘- selected point (you can

[ I Output ) also enter numerical
values)

The brightness and contrast of the image change.

The horizontal axis shows the input level and the vertical axis
shows the output level.

The maximum number of [[]] is 10.

To delete a [[1], select the [[Od] and then either press the <Del>
key on the keyboard or double-click on the [[].

@ Note that if you adjust the tone curve in the [Basic] tab after making
adjustments with the [Six Color-Axes] tab sheet or [Specific Colors]
tab sheet, the color characteristic will be further adjusted and
intended image characteristics may not be achieved. To further
adjust brightness and contrast after adjusting with the [Six Color-
Axes] tab sheet or [Specific Colors] tab sheet, use the tone curve for
adjusting luminosity in the [Specific Colors] tab sheet.
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Adjusting Color .
Introduction
You can adjust the color region you selected using hue, saturation, and Select the color region you want to adjust.
luminosity.
(] [ A
Select the [Six Color-Axes] tab in the [Tool palette]. - Contents
—
Load a Picture Style file (p.10)
Preparing
Save a Picture Style file (p.18) a Sample
Hue region select buttons
(this page) Basic
Windows
Select the color region you want to adjust from the adjustment
Adjustment color wheel color wheel. ) o )
(this page) You can also select the color region by clicking a hue region Pre-adjustments
select button.

Adjust the upper and lower hue limits for the
selected region.

Image
Characteristics

Hue adjustment sliders (p.13)
Saving
—_—
. ; | Preferences
The [Six Color-Axes] tab sheet appears.
—_—
You can adjust the upper and lower hue limits for the selected
region by dragging the boundary lines for each hue in the S GIEEIER
direction of the circumference. —_—
|§| Note that if you adjust a color with the [Basic] tab sheet after making
adjustments with the [Six Color-Axes] tab sheet, the color
characteristic will be further adjusted and intended image @ @
characteristics may not be achieved. We recommend that you make
adjustments in the following order. @
(1) Adjust using the [Basic] tab sheet, (2) adjust using the [Six

Color-Axes] tab sheet, (3) adjust using the [Specific Colors] tab
sheet.



Making Minute Adjustments to Color

Adjust color. You can make minute adjustments to a color you have specified, using
the hue, saturation and luminosity functions in order to get the color you
want. You can also set a range for the effect on surrounding colors
which occurs when you adjust the colors you have specified.

Select the [Specific Colors] tab in the [Tool palette].
Load a Picture Style file (p.10)

Drag the sliders to adjust color. You can also directly enter values
to adjust.

H: Adjust hue.

S: Adjust saturation.

L: Adjust luminosity.

S| Save a Picture Style file (p.19)

Minute adjustments to
a specified color (p.14)

il Adjustment color list (p.16)

Color display mode (p.17)

L Adjust the gamma characteristic for luminosity (p.17)
The [Specific Colors] tab sheet appears.

|§| Note that if you adjust a color with the [Six Color-Axes] tab sheet or
[Basic] tab sheet after making adjustments with the [Specific Colors]
tab sheet, the color characteristic will be further adjusted and
intended image characteristics may not be achieved. We
recommend that you make adjustments in the following order.
(1) Adjust using the [Basic] tab sheet, (2) adjust using the [Six Color-
Axes] tab sheet, (3) adjust using the [Specific Colors] tab sheet.
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Introduction
Specify the color you want to adjust. Determine the range of effect for the color you want
Click the [[" 2 ] ] button and then click the color you want to to adjust.
adjust on the image. Within the frame is the range of effect Contents
Tool palette _—— Color of the adjustment point selected in step 2 _
Basic _' ) Six Color-Axes / Specific Colors Preparing
' a Sample
B Show affected area on images .
Basic
Windows
upper and
lower limit of Pre-adjustments
luminosity
move up or |
down mage

Characteristics

Luminosity level of the adjustment
point selected in step 2 Saving

Range of upper and lower limit of saturation -~
Drag to move towards the center or towards
the outer perimeter

The selected color is displayed as an adjustment point [{C1] on Preferences
the color wheel. Range of upper and lower limit of hue
Drag to move along the circumference
The range of effect for hue, saturation, and luminosity can be set Reference
within the limits below. L J

Setting Range
Hue 30 - 180 degrees @ @
Saturation 30-100 @

Luminosity 30 - 100



Introduction
Adjust the color. Check the range of application.
If you checkmark [Show affected area on images], the range of
application of the adjusted color blinks on the image.
_ Contents
_
Preparing
a Sample
B Show affected area on images
7
Basic
Windows
. . S ——
Repeat steps 2 to 5 to adjust multiple colors.
You can select and adjust colors for up to 100 spots. :
Pre-adjustments
S —

Image
Characteristics

Drag to the left or right to adjust
. . e Saving

The color is adjusted to the range specified in step 3 and the

color of the image changes. —

When dragging the slider, the point before adjustment [({(1] and

the point after adjustment [ il ] will be displayed on the color Preferences

wheel. -

Reference

e

|§| When using EOS Utility’s Remote Live View function with PSE to @ @
edit Picture Styles, the [Show affected area on images] checkbox

is not displayed, and you cannot check the range of application of @
adjusted colors.
You can also specify the color to be adjusted in the method

different from the one explained in step 2 (p.16).
15



Specifying the Color Directly

In addition to specifying the adjustment point by clicking the color on the
image (p.14), you can also specify the color directly on the color wheel
or by entering the color value.

Specifying the Color on the Color Wheel
Click the [[# ]] button (p.14).

Click the color you want to adjust on the color wheel.

The selected color is displayed as an adjustment point [{C1] on
the color wheel.

Specifying the Color by Entering the Color
Value

Select the [Edit] menu » [Specify the numerical
values for color adjustment].
The [Specify the numerical values for color adjustment] window
appears.

Enter the color value.
The entered color value is displayed as an adjustment point [ ()]
on the color wheel.

Displaying the Adjustment Color List and its Functions

In addition to displaying colors before and after adjustment, the
adjustment color list (p.8) shows overlapped range of effect of adjusted
colors, and has a checkbox for specifying whether applying adjusted
colors or not.

Color before adjustment

Color after adjustment

Displays overlapped range of effect of adjusted colors
Remove the checkmark to disable the adjustment

Overlapped Range of Effect of Adjusted

Colors

When you select an adjusted color from the list and [:';'__u] appears, the
range of effect of the adjusted color (p.14) is overlapping with the range
of effect of other adjusted colors.

Moreover, the overlapped areas will be displayed in gray on the color

wheel and an adjustment combining the original adjustments is applied.

To avoid an overlapped ranges of effect, select the subject color with
[1I:] and adjust it again so that the range of effect of the hue and
saturation no longer overlap.

Deleting an Adjusted Color

Be aware that you cannot recover deleted colors.

From the list, select the adjusted color you want to

delete and then press the <Del> key on the keyboard.

The selected adjusted color is deleted.
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Introduction
Color Display Mode Adjusting the Gamma Characteristic for Luminosity
You can select the color display mode which will be the basis for color You can adjust the brightness and contrast for the luminosity of the S
adjustment from three options (HSL, Lab, or RGB) as well as checking entire image using the tone curve. To further adjust contrast and ontents
values for adjusted colors. brightness after adjusting image characteristics with the [Six Color-
Axes] tab sheet or [Specific Colors] tab sheet, use the tone curve in this
[Specific Colors] tab sheet. Preparing
a Sample
SWzCheS the color display Adjust the brightness and contrast.
mode
Basic
Windows
Click to add a [[1]
(agljustment poipt) and Pre-adjustments
adjust by dragging

—_

Image
Characteristics

Color value after adjustment

Color value before adjustment

The value of the
selected point (you can

When “HSL” is selected for the color display mode, you can only also enter numerical Saving
change the color value for before adjustment by entering a values)
number.
The brightness and contrast of the image change. S
es

The horizontal axis shows the input level and the vertical axis
shows the output level.

The maximum number of [[]] is 10.

To delete a [[], select the [[O] and then either press the <Del> Reference
key on the keyboard or double-click on the [[].

@ HSL is a color display mode using the three elements of hue (H),
saturation (S), and luminosity (L).

Lab is a color mode developed by the CIE (Commission

Internationale d’Eclairage) where L is for lightness, a for color @ @
elements from green to magenta, and b for color elements from

blue to yellow. @

RGB is a color display mode using red (R), green (G) and blue
(B), the three primary colors (additive colors) of the visible light
spectrum.



Saving the Adjustments as a Picture Style File

Adjustments specified in the [Tool palette] (p.10 to p.17) are saved on your
computer as an original Picture Style file (extension “.PF2” or “.PF3”).
The adjustments are saved as a Picture Style file which is separate from
the sample image, and the sample image used to perform the
adjustments is not affected at all.

Click the [[&]] button.

The [Save Picture Style file] window appears.

Specify the file name and save destination and then

click the [Save] button.
Only one-byte characters can be entered in the [File name],
[Caption], and [Copyright] boxes.
If you do not want to show the settings adjusted in PSE,
checkmark [Disable subsequent editing] and save, so that the file
cannot be opened again in PSE.

Save - My Documants. - @O
= Name = Uate moditied Iype
o No items match your search.
Recent Places
Desktop
Libreries

Computer

-

Network

Fie game: | - [ seve ]

Save astype PF2(pi?) - Cancel

Caption
Gopyright

Disable subsequent aditing

The file is saved as a Picture Style file in the specified save
destination.

® Results of the following adjustments are not saved if saved in PF2

file format. Be sure to save results in PF3 file format.

- Adjustments made with [Fineness] or [Threshold] for [Sharpness]
in the [Basic] tab sheet

- Adjustments made with the tone curve in the [Basic] tab sheet

- Adjustments made with the [Six Color-Axes] tab sheet

Even if you checkmark [Disable subsequent editing] and save, you
can use the Picture Style file the same way as the Picture Style file
without chekmarking and saved (p.19). However, you will no longer
be able to open the Picture Style file in PSE. For this reason, we
recommend that you save separately beforehand the Picture Style
file without checkmarking [Disable subsequent editing].
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Using a Picture Style File

Saved Picture Style files can be registered in the camera and applied to
shot images. They can also be applied to RAW images using DPP.

Registering a Picture Style File to the Camera

Picture Style files saved on your computer can be registered to the
“Camera that has a Picture Style function settings” (For information on
whether your camera is equipped with the Picture Style function, refer to
the camera’s Instruction Manual.) using EOS Utility and applied to shot
images.

Refer to “Applying Picture Style Files to the Camera” in “EOS Ultility
Instruction Manual” (PDF electronic manual) for details on operation.

® Picture Style files created with [Base Picture Style] set to [Fine
Detail] cannot be registered to the cameras which do not have [Fine
Detail] as a preset Picture Style.

Using a Picture Style File with DPP

Picture Style files saved on your computer can be applied to RAW
images using DPP.

Refer to “Using a Picture Style File” in “Digital Photo Professional
Instruction Manual” (PDF electronic manual) for details on operation.
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Preferences Exiting PSE

You can perform color management settings such as specifying the In the main window, select the [File] menu » [Exit].
work color space for the sample image displayed in the main window, or PSE exits.

setting the profile for the monitor.

Select the [Tools] menu » [Preferences].
The [Preferences] window appears.

Specify the required settings and then click the [OK]
button.

Default settings of Work color space
@ sRGB
() Adobe RGB

Color matching settings

@ sRGB

() Manitor profile

The settings are applied.

|§| If you have changed the work color space during the adjustment
process, the adjustment point on the color wheel may move in
conjunction with the selected work color space.
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Reference
Troubleshooting

If PSE is not operating correctly, refer to the items below.

Installation could not be completed correctly

Select an administrator-level privilege ([Computer administrator],
[Administrator], etc.) as a user setting. You cannot install the software
if a user setting other than an administrator-level privilege is selected.
For detailed information on selecting an administrator-level privilege,
refer to your computer user’'s manual.

PSE does not work

PSE does not operate correctly on a computer if its system
requirements are not met. Use PSE on a computer with compatible
system requirements (p.2).

Even if your computer has the RAM capacity (memory) described in
the system requirements (p.2), if other applications are running at the
same time as PSE, you may not have sufficient RAM (memory). Exit
any applications other than PSE.

Images do not display properly

Sample images that are not supported by PSE (p.2) do not display.

Deleting the Software (Uninstalling)

Exit any applications before uninstalling the software.

Log in under an administrator-level privilege when uninstalling the
software.

To prevent computer malfunctions, always restart your computer after
you have uninstalled the software. Re-installing the software without
first restarting your computer is particularly likely to result in computer
malfunctions.

Windows 7

Select the [@)] button » [All Programs] » [Canon
Utilities] » [Picture Style Editor] » [Picture Style
Editor Uninstall].

Proceed with the uninstallation as directed by the
on-screen messages.
The software is uninstalled.

Windows 10, Windows 8.1, Windows 8

Uninstall the software according to the OS software uninstalling
method.
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About This Instruction Manual

It is prohibited to reproduce, in whole or part, the contents of this
Instruction Manual without permission.

Canon may change without notice the software specifications and
contents of this Instruction Manual.

The software screens and displays printed in this Instruction Manual
may differ slightly from the actual software.

Please note that irrespective of the above-mentioned, Canon does
not take responsibility for the outcome of the operation of the
software.

Trademark Acknowledgments

Microsoft and Windows are registered trademarks or trademarks of
Microsoft Corporation in the United States and/or other countries.
Other names and products not mentioned above may be registered
trademarks or trademarks of their respective companies.
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